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Introduction  

1. Introduction 
 

This User Guide provides system designers with information on how to use System Scope Rev 3.0. 

The tool supports the following operating system(s): 

1. Windows 10 64 bit 

The tool supports the following microprocessors: 

1. 6th Gen Intel® Core Processor Code name Kaby Lake Processor. 
2. Intel® Core Processor Line Code name Canon Lake Processor. 
3. Intel® Atom Processor Line Code name Gemini Lake Processor.  
4. Intel® Atom Processor Line code name Ice Lake Processor. 
5. Intel® Atom Processor Line code name Lake Field Processor 
6. Intel® Atom Processor Line code name Coffee Lake Processor 
7. Intel® Atom Processor Line code name Amber Lake Processor 
8. Intel® Core Processor Line Code name Whiskey Lake Processor. 
9. Intel® Core Processor Line Code name Comet Lake Processor. 
10. Intel® Core Processor Line Code name Jasper Lake Processor. 
11. Intel® Core Processor Line Code name EHL. 
12. Intel® Core Processor Line Code name Tiger Lake Processor. 

 

1.1 Revision History 
 

 

Revision Number 

 

Revision Data 
 

1.0 December 2014 

1.1 March 2015 

1.2 October 2015 

1.3 December 2015 

1.4 January 2015 

1.5 April 2016 

1.6 June 2016 

1.7 July 2016 

1.8 September 2016 

1.9 November 2016 

2.0 February 2017 
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2.1 April 2017 

2.2 
 

February 2018 

2.3 March 2018 

2.4 July 2018 

2.5 October 2018 
 

2.6 December 2018 

2.7 February 2019 

2.8 June 2019 

2.9 August 2019 

3.0 October 2019 

3.1 February 2020 

 

1.2 Terminology  
         

 

 

 

  

 

 

 

 

 

 
 

 

 

 

 

 

 

 
Term 

 
Description 
 

PCIE Peripheral Component Interconnect Express 

SMBIOS System Management Basic I/O System 

FPDT Firmware Performance Data Table 

PCH Platform Controller Hub 

ACPI Advanced Configuration and Power Interface 

OS Operating System 

BKC Best Known Configuration 

ME Management Engine 

MMIO Memory - Mapped I/O 

BMC Baseboard Management Controller 

TPM Trusted Platform Module 

SPS Server Platform Services 

TBT Thunderbolt 
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Installation 

2 .Installation 
 

The Intel ® System Scope Tool supports the following operating Systems. 

1. Windows 10 64 bit 

2.1 Installation on Windows 
 

The tool supports the following browsers. 

1. IE10 

2. IE11 

3. Firefox 

4. Google Chrome 

5. Microsoft Edge 

 Installation Instructions: 

1. The Intel® System Scope Tool comes as an Installer package. Run the Intel(R) 

SystemScopeInstallerWinInternal.exe file as administrator and follow the onscreen 

instructions to install the application. 

 

2. To launch the application, point to the shortcut created in the Strat menu or Desktop 

(Intel® System Scope Tool.htm) and run by clicking the shortcut. 

 

3. After tool launches click on “Allow blocked content” button. 

4. To uninstall/Stop the Service, close all the instances of the tools, by clicking on the 

close button of the browser. 

 

5. To uninstall the tool, open Add/Remove programs from the Control Panel and click 

on Intel® System Scope Tool and hit Change/Remove button. 

 
To Re-install or Upgrade the tool: 
  

1. To uninstall the tool, open add/Remove programs from the Control Panel and click on 
Intel® System Scope Tool and hit Change/Remove button. 
 

2. After uninstalling the existing tool, run Intel(R) SystemScopeInstallerWinInternal.exe 
and select install. 

 

3. Another way to upgrade the tool is, get the new Installer package and run Intel(R) 
SystemScopeInstallerWinInternal.exe directly. This first uninstall the existing tool and 
install the new one. 
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Software 

 

3. Software 
 

Click on "Software" tab to get the software details of the system. 

This includes the Application List, OS Information, Device Stack List, Driver List, Service List, 

              Module memory Information, Bkcmeta information, registry information, Environment Variables, 

 Running Tasks and Startup Programs 

  

Figure 3.0 Software 
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Software 

3.1 Application List 
 

 Click on the “Application List” to get the list of applications installed on the system. 

 It displays the list in two categories, namely Intel and Non-Intel application. 

 

Figure 3.1 Applications Information 
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Software 

3.2 BKCMeta Information 
 

This module displays BKC meta Information on system. It gives the complete information like  

 Build, creation, date, name, platform type, program name, version, type and workweek. 

 

Fig 3.2 Bkcmeta Information 
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Software 

3.3 Device Stacks 
 

This module displays Device Stacks Information on system. This tab will give the complete  

Information of devices stacks caption hardware ID, compatible ID, status, controlling service and 

Class GUID. 

 

Figure 3.3 Device Stack Information 
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Software 

3.4 Drivers Information 
 

 Click on “Drivers” tab to get the Device, Hardware ID & Driver Version for the Devices. It will also  

display the digital signature status of the driver. 

 

Fig 3.4 Driver Information 
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Software 

3.5 Environment Variables 
  

 This module displays all the Environment paths set in the system. 

 

Fig 3.5 Environment Variables 
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Software 

3.6 Module Memory Information 
 

 This module displays every module’s memory information on system. 

 This tab will give all modules name based on start address and end address available on board. 

 

Fig 3.6 Module Memory Information 
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Software                                                                                                                        

3.7 OS Information  
 

Click on “OS Information” tab, it displays the build number, build type, caption, code set install  

Date, OS architecture, language and system directory of operating system. It gives the complete 

Information of operating system. 

 

Fig 3.7 OS Information 
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Software 

3.8 Registry Information 
 

 This tab gives the complete registry information available on machine. It gives the name of  

Registry and data related to particular registry. 

 

Fig 3.8 Registry Information 
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Software 

Steps to retrieve of Registry Information  
 

  RegistryKeys.xml is present in the location C:\ProgramData\SystemScopetool. 

 RegistryKeys.xml contains Registry key name. If user want to add more registry names, 

 Open Registry.xml document with any editor, add registry names and save the xml 

 Document with any editor, add registry names and save the xml document. To see the  

 New changes refresh tool and navigate to Registry information. 

 

 

Few registry keys will not have permission to read. Check the permission level of key  

Before adding into the Registrykey.xml. 

 

Fig 3.8.1 Registry permission Allowed 
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Software 

Fig 3.8.2 Registry permission Restricted 

 

 

 

3.9 Running Tasks 
 

 This module gives all the current running processes in the system. 

Fig 3.9 Running Tasks 
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Software 

3.10 Service Information 
Click on “Services” to get the list of services installed on the system. It also displays the service 

type and the current status, description, trigger type and delayed auto start. 

Fig 3.10 Services Information
 

 

 

3.11 Startup Programs 
This Module gives all the programs which automatically starts when the system boots i.e., Startup 

Programs. 

Fig 3.11 Startup Programs 
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System 

 

4. System Information 
 

 Click on the “System” tab for viewing the system information. 

 

Fig 4.0 System 
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System 

4.1 ACPI 
 

 Click on “ACPI” tab to view the ACPI details. This tab will give the complete information of            

 Advanced configuration and power interface. 

 

Fig 4.1 ACPI 
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System 

4.2 Battery Information 
 

 Display the complete information of the battery connected to the computer system. 

 

Fig 4.2 Battery Information 
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System 

4.3 BCD Store Entries 
 

 Display the complete information of the BCD Store Entries. It retrieves the key and value of  

 Window boot manager and window boot loader. 

 

Fig 4.3 BCD Store Entries 
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System 

4.4 Components Information  
 

 This tab display the Complete Component information available on board. It displays the  

 Information about the camera device, input device, multimedia, ports, sound device and USB 

 Device available on machine. 

 

Fig 4.4 Components Information 
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System 

4.5 FPDT  
 

 Click on “FPDT” tab, it displays the FPDT information, FPDT log, GUID and GUID without string. 

 

Fig 4.5 FPDT 
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System 

4.6 Firmware Version 
 

 Displays the Firmware versions for the device. It displays the version and component name of 

 Group associates with different types. 

 

Fig 4.6 Firmware Version Info 
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System 

4.7 Generic System Information 
 

 Displays complete information of the System summary information and system power capabilities 

 Available on the board. This tab will give information about generic system information and 

 System power capabilities. 

 

Fig 4.7 Generic System Information 
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System 

4.8 Graphic Information 
 

 This shows information about the graphics. It shows the value of the T3 panel timing, 

 Baseband version, Baseband product and some general information and graphics. 

 

Fig 4.8 Graphic Information 
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System 

4.9 ICC Information 
 

 Displays complete Information of the ICC content on the board. This tab will give integrated 

 Clock circuit tool version and clock details. 

 

Fig 4.9 ICC Information 
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System 

4.10 ME Information 
 

 Displays the complete set of Information about the ME Information, ME firmware version and  

 ME capabilities and IPT related Information. Install ME driver to view complete Information. 

 (ME driver version should be greater than or equal to ME firmware version) 

 

Fig 4.10 ME Information 
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System 

4.11 Memory 
 

 Click on “Memory tab” to get the memory details. 

 This tab will give the information about memory. 

 The details of all memories connected to the system (Hard disk, RAM and Removable Storage). 

 

Fig 4.11 Memory 

 

 

 

 

 

 

 



 

  

36                                                            Intel confidential                                                          User Guide 
 

System 

4.12 Bluetooth 
 

 This module gives the data of Paired and Visible Bluetooth Devices. 

 

Figure 4.26 Bluetooth 
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System 

4.13 Network Adapter Information 
 

 Display the complete set of information about the network adaptors. This tab retrieves the 

 Complete information about network data. It displays the description and value of net connection 

 ID, status, Mac address and information relate to network adapters. 

 

Fig 4.13 Network Adaptor Information 
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System 

4.14 PCH Information 
 

 Click on “PCH” tab, it displays the complete information of the processor controller hub details 

 PCH DEVID, PCH STEPPING VALUE. 

Fig 4.14 PCH Information 

 

4.15 WWAN 
 This module gives the interface capabilities and basic information of connected WWAN device. 

Figure 4.15 WWAN 
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System 

4.16 Processor Information 
 

 Click on “Processor Information” to view the complete processor information. It contains topology, 

 Instructions, p state. This will displays the complete information about processor available on 

 Board. 

 

Fig 4.16 Processor Information 
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System 

4.17 Sensor Information 
 

 Displays complete information of the sensors available on the board. This tab will give information 

 About sensors. It displays the information about sensor properties available on machine. 

 

Fig 4.17 Sensor Information 
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System 

4.18 SMBIOS 
 

 Click on “SMBIOS” tab to view the complete information. This is BIOS dependent. 

 SMBIOS needs to export this information through SMBIOS details. 

 

Figure 4.18 SMBIOS 
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System 

4.19 Storage 
 

 Click on “Storage” tab to get the storage details. This tab will give the information about the 

 Caption, firmware revision, interface type, manufacturer, media type, model and serial number. 

 

Figure 4.19 Storage 
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System 

4.20 System Responsiveness Information 
 

 Click on complete System Responsiveness Information to view the timing information for boot, 

 Hibernate and sleep. 

 

Figure 4.20 System Responsiveness Information 
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System 

4.21 TPM Information 
 

 Click on “TPM Information” tab to get the TPM details. This tab will give information about TPM. 

 This tab displays the manufacturer info and TPM vendor ID and version. 

 

Figure 4.21 TPM Information 
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System 

4.22 DMA 
 This module gives the information about DMA (Direct Memory Access). 

Figure 4.22 DMA 

 

 

4.23 IRQ 
 This module give the information about all the Resource – Device IRQ numbers. 

Figure 4.23 IRQ 
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System 

4.24 BIOS Options 
 

 This module displays all the options in the Bios page along with their current value. 

 

Figure 4.24 BIOS Options 
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System 

4.25 Multimedia 
 

 This module gives the data of all the audio and video devices. 

 

Figure 4.27 Multimedia 
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PCIe 

5. PCIe Information 
 

 Click on the “PCIe” tab for viewing the PCIe Information. 

5.1 PCIDevList 
 

 Click on “PCIDevList” tab to get the details of pcidevlist. This tab gives complete  

 PCI information, PCI Header Register and PCI dump 

Figure 5.1.0 PCIDevList 
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Generate BKC 

6. Generate BKC 
 

 After select the Generate BKC from add-on, the following BKC page is displayed. 

 Click on “Generate BKC” tab to generate and compare BKC’s. 

 

Figure 6.0 Generate BKC 
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Generate BKC 

6.1 Generate Reference File 
 

 Use this option to generate the reference file for the selected one. 

 Click on “Generate Reference File”, displays the list. Select any one from the list and click on  

 “Save reference file”. 

Figure 6.1 Generate Reference File 

 

Figure 6.1.1 Generated Reference File Result 

 

Click on the hyperlink to open the file. File will be opened in default browser. 
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Generate BKC 

 

Figure 6.2.2 BKC Generation from Template / Config File 

 

 

 

User can also generate BKC File by selecting the ‘Default Config File’ option. This will create BKC File for 

the default BKC Template present in the tool install location. 

User can also enter any custom path for BKC Template by selecting the ‘Custom Config File’ option and 

enter the file name. 
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BKC And Log Compare 

 

7. BKC and Log Compare 
 

 BKC and Log Compare Tab from add-on, has two features namely BKC Compare and Compare 

Logs.  

Figure 7.0 BKC And Log Compare 

 

7.1 BKC Compare 
 On click on BCK Compare, corresponding tab will expand. Here we can compare the BKC File  

With system configuration. We can provide BKC Reference File, BKC Template and XML log file. 

Figure 7.1.0 BKC Compare 
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BKC and Log Compare 

 

After Click on Compare, Overall Summary of the Comparison will be displayed and Comparison HTML 

and XLS report will be saved. After Click on View result the comparison report will open in the default 

browser. Result file is accessible from browser, only if the user is an administrator. 

Figure 7.1.1 BKC Overall Summary 

 

 

 

Figure 7.1.2 BKC Compare HTML Report 
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BKC And Log Compare 

 

7.2 Compare Logs 
 

 Compare Logs Option will compare multiple Systemscope xml Logs. Input should be the folder 

Path which contains all the xml logs which are to be compared. Click on compare, on successful  

Comparison the report will be saved in XLS format. 

 

Figure 7.2.0 Compare Logs 
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BKC And Log Compare 

 

Figure 7.2.1 Compare Logs Result Pop up 

 

 

 

Figure 7.2.2 Compare Logs Sample XLS Report 
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Crash Tool Settings 

8. Crash Tool Settings 
 

 After select the crash tool settings from add-on, the following crash tool page is displayed. 

 

Figure 8.0 Crash Tool Setting 
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Crash Tool Settings 

8.1 Settings 
 

 Initially registry form filled with some default values, for saving that values just click on 

 “Save” button. Settings will be saved successfully. 

 

Figure 8.1 Settings 
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Crash Tool Settings 

 If user wants to change the initial register values, then change the values and click on “save”. 

 System reboot popup is appear. 

 If click on “ok”, the system is reboot. 

 If click on “cancel”, the registry values are displayed. 
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SystemSummary 

9. System Summary 
 

 This feature of SystemScopeTool lists all the important fields of the Tool when the tool is  

Launched and also when the user clicks on the System Summary tab. 

 

Fig 9.0 System Summary  
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Crash History 

 

10. Crash History 
 

 On Click of Crash History Tab, Intel (R) Crash Analysis Tool.html page will open. It will display all 

the crashes reported. 

Figure 10.0 Crash History 

 

 

Figure 10.1 Crash tool HTML page 
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Workspace 

11. Workspace 
 

SST provides an option to save all the settings in a workspace file and transfer this file to other   

Machines and even across operating systems. 

Once all the settings are finalized, go to File-> save workspace and save the .xml file. 

 Refer Figure 19.2 and 19.3 to find a way to save and load the workspace. 

 When you want to transfer these settings to another machine, copy this workspace file to the new 

 Machine and load the workspace file using File-> Load workspace. 

 

Figure 11.0 Workspace 
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Workspace 

11.1 Save workspace 
 

 The user has an option to save the following options in to a workspace file. 

1. General: Under Tools->settings->General  tab user can save enable auto refresh, polling 

         Period, participate SST3 improvement and FPDT settings. 

2. Logging: Under Tools->settings->Logging tab user can save default path for log file, 

    Format option (html, xml, csv and both xml and html) and module selection. 

 

 After clicking save workspace, below dialog box will appear. You can save the work space at  

 Default location or else you can enter a location of choice. 

 

Figure 11.1 save Workspace 
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Workspace 

11.2 Load Workspace 
 

 Clicking on the load workspace option in Figure 19.0 will open the below dialog box. 

 Choose the required workspace file and click on “submit” button for loading the workspace. 

 

Figure 11.3 Load Workspace 
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Settings 

 

12. Settings 
 

 Click on “Settings” menu item to view/modify general and logging settings under Tools menu. 

 

12.1 General 
 

 This window allows the user after submitting FPDT settings, then for any next module if we 

 Opened, it should refreshes whole tab. 

 

Figure 12.0 General 

 

 

 

 

 



 

  

65                                                            Intel confidential                                                          User Guide 
 

Settings 

 

12.1.1 Participate in SST3 improvement program 
 

 System Scope Tool has a product improvement program, you can participate by accepting the  

 License agreement of Intel® participate improvement program after installation or after launching 

 UI enable it from Setting -> General tab. Please refer to Figure 12.0 for the options screen shot. 

 

 

12.1.2 Auto refresh 
 

 If user enter polling period value (The value greater than 5 minutes and should be enter in  

 Milliseconds. The default is 5 minutes) and check the “Enable Auto Refresh” option, then 

 Select any FPDT settings and click on “Ok” for any next module if we opened, it should refresh 

 Whole tab after complete the polling period time. . Please refer to Figure 12.0 for the options   

Screen shot. 

 

 

Note: “Enable Auto Refresh” option should be selected in order to save Polling Period with custom time. 
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Settings 

12.1.3 Save Log  
 

 This window allow the user to choose the format of log file. 

It also provides an option to view/modify the logging features from here by clicking on the 

 “Log Settings” button. It redirects to “Settings” window. 

Figure 12.1.3 Save Log popup 

 

Figure 12.1.4 save Log Result 
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Settings 

 

12.2 Logging 
 

 This window allows the user to choose the features to be logged. You can save the log file from 

 Here by clicking on the “Save Log” button. It redirects to save log window. 

 

Figure 12.2 Logging 

 

 

 

 This window allow the user to choose the format of log file. It provides an option to select the 

 Folder where the log file has to be saved. 

 It also provides an option to view/modify the logging features from here by clicking on the 

 “Log Settings” button. It redirects to “Settings” window. 
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Command Line Operations 

13. Command Line Operations 
 

 Saving the log from command prompt. 

 Syntax: SystemScopecmdLine.exe –log <Log file name.format> [-options]. 

 Here, 

  -log  : Log command 

  Log filename      : file path 

  Format  : xml/html/json/csv 

  Options  : Optional parameter, if it’s not passing, it generates entire log 

      Otherwise specified module(s)/plugin(s) combination of modules 

      And plugins. 

 Note: If the user doesn’t give File path, log file will save in tool install location. 

 

Figure 13.1 Saving the System Scope entire log in xml format 
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Command Line Operations 

Figure 13.2 Saving the Applications List 

 

 

Figure 13.3 Saving the Operating Systems Info 

 

 

 

Figure 13.4 Saving the Operating System Architecture 
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Command Line Operations 

Figure 13.5 Saving the Operating System Version 

 

 

Figure 13.6 Saving the Driver List 

 

 

 

Figure 13.7 Saving the Device Stack List 
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Command Line Operations 

Figure 13.8 Saving the Services List 

 

 

Figure 13.9 Saving the Registry Info 

 

 

 

Figure 13.10 Saving the BKC Meta Information 
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 Command Line Operations 

Figure 13.11 Saving the Module Memory Information 

 

 

 

Figure 13.12 Saving the ACPI Information 

 

 

 

Figure 13.13 saving the sensor Information 
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Command Line Operations 

Figure 13.14 saving the BCD Info 

 

 

Figure 13.15 Saving the Components Information 

 

 

Figure 13.16 Saving the FPDT Information 
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Command Line Operations 

Figure 13.17 Saving the Firmware Information 

 

 

Figure 13.18 Saving the Bluetooth Information 

 

 

 

Figure 13.19 Saving the ICC Information 
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Command Line Operations 

Figure 13.20 Saving the ME Info 

 

 

 

Figure 13.21 Saving the Memory Info 

 

 

 

Figure 13.22 Saving the Network Adaptor Information
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Command Line Operations 

Figure 13.23 Saving the PCH Information 

 

  

Figure 13.24 Saving the Processor Information 

 

 

 

Figure 13.25 Saving the SMBIOS Information 
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Command Line Operations 

Figure 13.26 Saving the Multimedia Information 

 

 

  

Figure 13.27 Saving the Storage Information 

 

 

 

Figure 13.28 Saving the System Responsiveness information 
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Command Line Operations 

Figure 13.29 Saving the Generic System Information 

 

 

 

Figure 13.30 Saving the TPM Information 

 

 

 

Figure 13.31 Saving the PCIDevList 
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Command Line Operations 

Figure 13.32 Saving the Complete Software Information 

 

 

 

Figure 13.33 Saving the Complete System Information 

 

 

Figure 13.34 Saving the PCIe 
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Command Line Operations  

Figure 13.35 Saving the BKC Compare Log 

 

  

Figure 13.36 Saving the WWAN Information 

 

 

 

Figure 13.37 Saving the Generate BKC Reference File 

 

 



 

  

81                                                            Intel confidential                                                          User Guide 
 

Command Line Operations 

Figure 13.38 Saving the Environmental Variables 

 

 

Figure 13.39 Saving the Startup Programs 

 

 

Figure 13.40 Saving the Running Tasks 
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Command Line Operations 

Figure 13.41 Saving the DMA 

 

 

Figure 13.42 Saving the IRQ 
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Command Line Operations 

Figure 13.43 System Scope Tool All Commands List 
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Command Line Operations 

 

 In Command line, if the user enters the invalid command other than the valid  

System Scope Commands, and if that entered command is present in CustomLog.xml file, a log file will  

Be generated with the modules corresponding to that command present in the CustomLog.xml file. This  

Xml file is present in “C:\Program Data\SystemScopeTool”. User can edit the file and can change the  

Modules list as per their requirement. 

 

Figure 13.44 Saving the Custom Log Modules 

 

 

 

Figure 13.45 Format of CustomLog.xml 
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Command Line Operations 

  In Command line, for –generatebkc, -comparebkc, -compare2bkc the user has to  

Provide the input file name and the result will be saved in default file. Now there is an option to provide  

The output file name along with the command. If the user enters the custom path the file will be save in  

Custom path or else if the user doesn’t provide any file name the output will be saved in default file only.  

This is an optional parameter. 

Figure 13.46 Custom path option for generatebkc 

 

 

 

Figure 13.47 Custom path for comparebkc 

Third Parameter is the custom path here. Supported report formats are html, xls and json. Sample  

Screen shot of html format is attached below. 
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Command Line Operations 

 

Figure 13.48 Compare Multiple Logs 

 

 

Figure 13.49 Comparing Meta.spec with SystemScopeLog 

 This option will compare meta.spec file with SystemScopeLog and saves the result in HTML File. 
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Command Line Operations 

Figure 13.50 Logging the HSD-ES Fields (-hsdfields) 

 This option will log all the required fields for HSD-ES in JSON Format. 
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Main window 

14. Main Window 
 

 

14.1 File Menu 
 

 Click on the “File” menu item to get the options. 

 The menu allows you to launch the “Save Log” window 

 

Figure 14.1 File Menu 

 

 

 

14.2 Tools Menu 
 

 Click on the “Tools” menu item to get the options. 

 The menu allows you to launch the “Settings” & “Manage Connection” window. 

 

Figure 14.2 Tools Menu 
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Main window 

14.3 Help Menu 
 

 Click on the “About” menu item to get the options. 

 The menu allows you to launch the “About” & “Help” window. 

 

Figure 14.3 Help Menu 

 

 

 

Figure 14.3.1 About 
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Save and Save FPDT Log 

15. Save and Save FPDT Log 
 

 

15.1 Save 
 

 Save option can be used for saving the system scope data. We can save the data in xml, html, 

 Csv or both xml and html formats. 

 

Figure 15.0 Save 
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Save and Save FPDT Log 

  

If user want to change settings just click on “Log Settings” button. Then modify the Log data  

 By checking or unchecking the required fields. 

 

Figure 15.1 Modifying the Log 
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Save and Save FPDT Log 

 

15.2 Save FPDT Log 
 

 Save FPDT log option can be used to save the FPDT log. 

 

Figure 15.2 Saving the FPDT Log 

 

 

 

 If select “yes”, it will be saved. 

 If select “no”, popup will be closed. 
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SaveLog in All Formats And BkcCompare 

16. Save Log in All Formats and BKC 

Compare 
  

SST provides an option to save the System Scope Log files in all supported formats (.xml, .html, 

.csv and .json) and also to compare BKC with system Configuration in single click. These two options are 

added under File Menu. This operations can also be done by clicking the shortcuts present in start menu. 

 

16.1 Save log in All Formats 
 

 On clicking this option, System Scope log with all the modules present will be save in all the  

Mentioned formats. 

 

Figure 16.0 save log in All Formats 

 

 

Once the save log operation is done, a popup is displayed with paths of all the formats created 
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SaveLog in All Formats And BkcCompare 

16.2 BKC Compare 
 

 On Clicking this option BKC file is compared with the system configuration. User can input the  

BKC file in the SingleClick.ini file provided at the time of installation. If no file is present BKC file is  

Generated from the Default BKC template provided and comparison will be done with that file. 

 

Figure 16.1 BKC Compare 

 

 

 

Once the BKC compare operation is done, a pop up is displayed showing the path of the  

Comparison result. 
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SaveLog in all Formats And BkcCompare 

 

 There is another option for these single click operations. By clicking on the shortcut present in  

the start menu we can get the results without opening the System Scope tool UI or  

Command Line. 

 

Figure 16.2 Shortcut option on Desktop 
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Load Custom Modules 

 

17. Load Custom Modules 
 

  This is a feature of System Scope Tool, which displays only the modules user  

intended. On click of Save Workspace option under File Menu, a pop-up is displayed that shows the tree  

list of all the presented modules in the platform. Here the user can uncheck the modules which they don’t  

want to see or load. 

 

Fig 17.1 Save Workspace popup to select modules to load 

 

 

 

 After unchecking the modules, click on save option and the workspace will be saved. Now click  

On the load Workspace option under the File Menu and select the workspace file and click on load. Then  

The tool will display on the modules which the user has selected. 
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Load Custom Modules 

 

Fig 17.2 Loading of Custom Modules 

 

 

 

  If the user again wants to load all the modules, click on save workspace under File Menu 

And check all the modules, save that workspace and load that again to see or load all the available 

Modules in the platform. 
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Support 

18. Support 
 

 Please contact your Intel representative or drop a mail to systemscopetool@intel.com, to report 

 any bugs or error events related to SystemScopeTool. 

 Kindly provide as many details as possible about the issue. This would help us resolve the issue  

 Faster without the need for many email exchanges. 
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